CAEn Building Editor Tool Manual

Denis R. Shine

DSTO-GD-0422
CAEn Building Editor Tool Manual

Denis R. Shine

Land Operations Division
Systems Sciences Laboratory

DSTO-GD-0422

ABSTRACT
Creation and modification of buildings within the Close Action Environment (CAEn) wargame can be a complex and time consuming task. The CAEn Building Editor Tool, or Builder, simplifies this process by providing an efficient graphical interface to edit CAEn buildings. The use of Builder can greatly speed up the production of urban environments within CAEn.

RELEASE LIMITATION
Approved for public release
CAEn Building Editor Tool Manual

Executive Summary

The Close Action Environment (CAEn) model is an analytical wargaming and simulation tool developed by the Defence Science and Technology Laboratory (Dstl formerly DERA) in the mid 1990s. The focus of the model is to enable the evaluation of small-scale infantry combat scenarios. CAEn includes the ability to create highly defined buildings as part of the underlying terrain, which in turn require input files with a complexity level that makes them difficult to edit by hand. To ease creation of buildings for CAEn, the CAEn Building Editor Tool, or Builder, was made. Builder provides a robust interface for the creation, editing, visualisation and management of CAEn buildings. Using this tool means CAEn buildings can be created in a fraction of the time required by previous methods, with a greatly reduced error rate.
Denis Shine
Land Operations Division

Denis Shine gained his B.I.T. majoring in Data Communications and B. App. Sci. (Mathematics) at the Queensland University of Technology in 2001. He commenced work at DSTO in 2002 in Land Operations Division and has since worked in various areas including wargaming and simulation, 3D modelling, urban modelling and abstract warfare simulation.
# Contents

1. **INTRODUCTION** ................................................................................................................ 1

2. **CAEN BUILDING FORMAT** ............................................................................................ 1  
   2.1 **Building** ...................................................................................................................... 2  
   2.2 **Floor Area** .................................................................................................................. 3  
   2.3 **Wall** ........................................................................................................................... 4  
   2.4 **Window** ....................................................................................................................... 5  

3. **BUILDER FUNCTIONALITY** ..................................................................................... 6  
   3.1 **The Defaults File** ....................................................................................................... 7  
   3.2 **Menus** .......................................................................................................................... 8  
       3.2.1 **File Menu** ........................................................................................................... 8  
       3.2.2 **Tools Menu** ....................................................................................................... 8  
   3.3 **Panels** .......................................................................................................................... 9  
       3.3.1 **Tree Panel** ......................................................................................................... 9  
       3.3.2 **Right Hand Side Panels** ..................................................................................... 10  
           3.3.2.1 **Building Panel** ............................................................................................. 10  
           3.3.2.2 **Floor Area Panel** .......................................................................................... 11  
           3.3.2.3 **Wall Panel** .................................................................................................... 12  
           3.3.2.4 **Window Panel** .............................................................................................. 13  
       3.3.3 **Building Display Panel** ....................................................................................... 14  

4. **TUTORIAL** ...................................................................................................................... 16
List of Figures

Figure 1 - Floor areas........................................................................................................... 3
Figure 2 - Example Builder main window ........................................................................... 6
Figure 3 - File menu........................................................................................................... 8
Figure 4 - Tools menu........................................................................................................ 8
Figure 5 - Tree panel......................................................................................................... 9
Figure 6 - Right clicking on a wall object in the tree panel.............................................. 9
Figure 7 - Building panel ................................................................................................ 10
Figure 8 - Floor area panel............................................................................................... 11
Figure 9 - Wall panel......................................................................................................... 12
Figure 10 - Window panel................................................................................................. 13
Figure 11 - Building display panel..................................................................................... 14
Figure 12 - 3D view........................................................................................................... 15
Figure 13 - Initial building structure................................................................................ 17
Figure 14 - Building plan after adding windows............................................................... 18
Figure 15 - Building plan after adding internal walls....................................................... 19
Figure 16 - Building plan after adding new floor area.................................................... 20
Figure 17 - Building plan after viewing floor 2............................................................... 20
Figure 18 - Building plan after adding windows to the conference room...................... 21
Figure 19 - Floor 2 after adding office walls .................................................................... 22
Figure 20 - Window panel display for first window on top floor..................................... 23
Figure 21 - Finished building, floor 1................................................................................ 24
Figure 22 - Finished building, floor 2............................................................................... 24
Figure 23 - Concatenation dialog example...................................................................... 25

List of Tables

Table 1 - Data at building level........................................................................................... 2
Table 2 - Data at floor area level......................................................................................... 4
Table 3 - Data at wall level................................................................................................ 5
Table 4 - Data at window level........................................................................................... 5
Table 5 - Building display panel colour scheme............................................................... 14
Table 6 - Front area external walls.................................................................................... 16
Table 7 - Front area internal walls.................................................................................... 18
Table 8 - Back area internal walls.................................................................................... 19
Table 9 - Back area top floor internal walls.................................................................... 22
1. Introduction

Close Action Environment (CAEn) is a wargaming and simulation tool used for simulating low level engagements of up to company size. Many of these scenarios take place in urban environments. In order to facilitate a high level of fidelity in modelling combat in urban terrain CAEn has a complex structure used to define buildings. This structure appears as a text file in one of CAEn’s many input directories.

At first, building generation was done by directly editing the text file, a time consuming and error-prone task. Following this, the Defence Science and Technology Laboratory (Dstl) developed a spreadsheet using Microsoft Excel that helped to speed up building creation by providing some of the structure of the building files and having the user fill in the gaps.

The spreadsheet provided a ‘Band-aid’ solution to the problem that was deemed inefficient. Numerous bugs, a lack of error checking and poor visualisation capability contributed to a need for a more complete solution. Builder provides this solution with a robust interface and error checking to stop the creation of invalid buildings. Builder also provides advanced 2D and 3D visualisation options.

The aim of Builder is to provide an interface for creating CAEn buildings with minimal effort. Builder can be used in any step of the building creation process, from converting old CAEn version 8 buildings, through editing existing buildings, to the merging of individual buildings into sets for input into CAEn. Finally Builder provides tools to view and output buildings in 3D formats.

2. CAEn Building Format

Before learning to use Builder itself, it is essential to know how CAEn buildings are defined. If you already have detailed knowledge of the CAEn format, this section can be skipped.

CAEn Urban files are formatted so that all the buildings required for a terrain are placed in a single file. This file is located in the ENVIRONMENT directory in CAEn and is named URBAN_FILE_<TERRAIN>.DAT, where <TERRAIN> is the name given to a particular terrain. As Builder works only on individual buildings, tools are provided to split CAEn Urban files into individual buildings and also to merge these individual buildings into a format readable by CAEn v9.2.0.0.

CAEn buildings have a specific format in a four tier hierarchy. The top level is building, followed by floor areas (not floors), followed by walls and then windows. From top down, the components have a one-to-many relationship. That is, a building can contain many
floor areas, but a floor area has only one parent building. Each component is intrinsically related to its parent in some way. Figure 1 provides a diagrammatical description of the hierarchy.

![Diagram of CAEn Building Hierarchy]

**Figure 1 - CAEn Building Hierarchy**

### 2.1 Building

A building is the top level of the hierarchy and contains little information in itself. Each building contains instead a number of floor areas. Each building, by default, must contain a floor area in order to work in CAEn.

**Table 1 - Data at building level**

<table>
<thead>
<tr>
<th>Field</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Building_type_number</td>
<td>Integer</td>
<td>A supposedly unique identifier for each building. CAEn ignores this number in any case, but it is useful for identifying which building is which.</td>
</tr>
</tbody>
</table>

Example:

Building_type_no 15
2.2 Floor Area

A floor area is a rectangular area of space containing part or all of a building. It does not necessarily represent a single floor level but can represent many floor levels, in order to simplify creation of something like a high-rise building. In addition to its own data, each floor area contains a number of walls. To further understand how floor areas work, see Figure 2.

![Diagram of floor areas in a building](image)

**Figure 2 - Floor areas**

In Figure 2 the building is not rectangular. Therefore it must be defined by several floor areas. Each floor area represents a single rectangular area. Table 2 contains the data for the floor area level.

Example:

```
Bottom_left_corner  0  0
Floor_size          8  6
Number_of_floors   1
Floor_toughness    0
Floor_heights      0.0
Roof_present       TRUE
Roof_height        3.0  4.0
North_south_ridge  FALSE
```
Table 2 - Data at floor area level

<table>
<thead>
<tr>
<th>Field</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bottom_left_corner</td>
<td>(Integer, Integer)</td>
<td>Specifies where this floor area starts in relation to the building itself. You must provide an x and y coordinate. These numbers are measured in metres.</td>
</tr>
<tr>
<td>Floor_size</td>
<td>(Integer, Integer)</td>
<td>Specifies the size of this floor. You must provide an x and y coordinate. These numbers are measured in metres.</td>
</tr>
<tr>
<td>Number_of_floors</td>
<td>Integer</td>
<td>Specifies the number of floors this floor area contains. Different floor areas of the same building may contain different numbers of floors.</td>
</tr>
<tr>
<td>Floor_toughness</td>
<td>Integer</td>
<td>Unknown how this affects CAEn. Left at 0 by default.</td>
</tr>
<tr>
<td>Floor_heights</td>
<td>{Float, Float,...}</td>
<td>A set of numbers that represent the height of the floor of each floor. For example, for the first floor of a building this should be 0.</td>
</tr>
<tr>
<td>Roof_present</td>
<td>Boolean</td>
<td>Defines if a sloped roof is present.</td>
</tr>
<tr>
<td>Roof_heights</td>
<td>(Float, Float)</td>
<td>Defines the lower and upper bounds of a sloped roof. To avoid confusion, the lower bound should generally be the top of the highest floor. (Actually this is true no matter what, there is no other place to specify the top of the highest floor). These numbers are measured in metres.</td>
</tr>
<tr>
<td>North_south_ridge</td>
<td>Boolean</td>
<td>Defines if the sloped roof runs a ridge on a north-south line.</td>
</tr>
</tbody>
</table>

2.3 Wall

A wall is contained within a floor area. Walls may occupy as many floors as its containing floor area will allow. Walls may not be angled in any way – they must be defined in a horizontal or vertical fashion. Each wall may contain a number of windows. Table 3 shows the data for the wall level.

The wall coordinates are relational to the wall’s containing floor area. This means that if a floor area has a bottom_left_corner defined at (1,3) and a wall within this floor area has a wall_start_coord (or wall_end_coord, this applies to both) of (4,5), then the actual position of the wall in terms of the building is (1,3) + (4,5) = (5,8).

Example:

Wall_present    TRUE
Wall_start_coord 0 0
Wall_end_coord  0 6
Wall_heights    1 1 0.0
Toughness       2500
Resilience      500
Table 3 - Data at wall level

<table>
<thead>
<tr>
<th>Field</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wall_start Coord</td>
<td>(Integer, Integer)</td>
<td>The wall starting coordinate in relation to its floor area. You must provide an x and y coordinate. These numbers are measured in metres.</td>
</tr>
<tr>
<td>Wall_end Coord</td>
<td>(Integer, Integer)</td>
<td>The wall ending coordinate in relation to its floor area. You must provide an x and a y coordinate. These numbers are measured in metres.</td>
</tr>
<tr>
<td>Floor_heights</td>
<td>(Integer, Integer, Float)</td>
<td>Specifies the floor this wall starts on, the floor it ends on, and how far above this top floor the wall continues. This last number is for buildings that have raised edges on the roofs.</td>
</tr>
<tr>
<td>Toughness</td>
<td>Integer</td>
<td>Unknown</td>
</tr>
<tr>
<td>Resilience</td>
<td>Integer</td>
<td>Unknown</td>
</tr>
</tbody>
</table>

2.4 Window

A window is the lowest level in the hierarchy. Each window can occupy any space along the length of the wall that contains it. Table 4 shows the data at window level.

Table 4 - Data at window level

<table>
<thead>
<tr>
<th>Field</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Floors</td>
<td>[Integer, Integer,...]</td>
<td>A set of integers specifying which floors the windows exist on. Keep these within the number of floors in the floor area.</td>
</tr>
<tr>
<td>Window Horizontal</td>
<td>Float, Float</td>
<td>The horizontal start and finish of the window along its wall, relational to the walls start coordinates. Keep these numbers within the length of the wall or it will appear in mid air. These numbers are measured in metres.</td>
</tr>
<tr>
<td>Window Vertical</td>
<td>Float, Float</td>
<td>The vertical start and finish of the window along its wall, relational to the walls lower and upper limits on each floor. These numbers are measured in metres.</td>
</tr>
<tr>
<td>Start_Block_B_L_I</td>
<td>Integer, Integer, Integer</td>
<td>No Documentation available. These variables are all used in fairly complex equations in the urban module.</td>
</tr>
<tr>
<td>Block_B_L_I</td>
<td>Integer, Integer, Integer</td>
<td>No Documentation available. These variables are all used in fairly complex equations in the urban module.</td>
</tr>
<tr>
<td>Toughness</td>
<td>Integer</td>
<td>Unknown</td>
</tr>
<tr>
<td>Resilience</td>
<td>Integer</td>
<td>Unknown</td>
</tr>
</tbody>
</table>
3. Builder Functionality

Builder provides an interface to view and edit all this information. The interface itself consists of 3 main panels as shown in Figure 3.

![Builder Interface](image)

*Figure 3 - Example Builder main window*

The top left panel is a tree structure representing the hierarchy of the building currently open. Navigating the tree is done just like using a program such as Windows Explorer.
The top right panel is an editing panel, which displays information about the currently selected building component in the top left panel. With this panel it is possible to edit the component, copy the component, remove the component, and add subcomponents to the component. More information about the various panels that can be displayed here is provided in the Panels section, section 3.3.

The bottom panel displays a floor plan of the current building. More information about this display is provided in the Panels section, section 3.3.

### 3.1 The Defaults File

When Builder starts, it loads a file by the name of defaults.txt, which should be located in the same directory as the program itself. An example of the defaults.txt file is provided below:

```
Building_Type_No1
Bottom_left_corner 0 0
Floor_size 10 10
Number_of_floors 1
Floor_toughness
Floor_height 0
Roof_present TRUE
Roof_height 3 4
North_south_ridge TRUE
Wall_present FALSE
Another_floor_area FALSE
Wall_start_coord 0 0
Wall_end_coord 10 0
Wall_heights 1 2 0
Toughness 2500
Resilience 500
Window_present FALSE
Floor_number 1
Window_horiz 3 4
Window_height 0.75 2
Start_Block_B_L_I 0 0 0
Block_B_L_I 14000 0 0
Toughness 200
Resilience 0
```

Any new Building, Floor Area, Wall or Window that is created will contain values extracted from defaults.txt. Note that it is possible for default floor areas and walls to contain walls and windows respectively. Simply add in the extra information as if it were...
a CAEn Urban file. Note again that it is NOT possible for buildings to contain floor areas by default. For descriptions of all the fields seen here, read section 2, CAEn Building Format.

3.2 Menus

3.2.1 File Menu

[Image: Figure 4 - File menu]

New: Create a new building from scratch. It creates a new building with no floor areas and a building_type_number of 1.

Load: Load a saved building from a file. The Load menu by default only shows files ending in the extension "*.dat". Note that this building is an individual entity that must be extracted by other means from a CAEN Urban File. The Tools menu has a tool to do this.

Save: Save the current building to file. Builder will save the file by default with the extension "*.dat", unless the user specifies another extension. The saved file exists as an individual building file and must be merged along with other building files into CAEn format in order to work within the wargame. The Tools menu has a tool to do this.

Exit: Exit the program.

3.2.2 Tools Menu

[Image: Figure 5 - Tools menu]

Split CAEN Urban File: This tool takes a CAEN Urban file and splits it into individual buildings. It names each individual building <Original filename>_Building_x.dat, where x is the n'th building in the CAEN Urban file.

Create Urban Terrain File: This tool is the opposite of the Split tool. It concatenates a number of individual building files into a CAEN Urban file. It uses two prompts to do this. The first one enables you to select all the files you want to concatenate, and the second one asks for a destination file to save them to. This tool also sorts the buildings by their building_type_number, which is described in section 2.1.

Create Wavefront Object File: This tool creates a 3D mesh of the building using the Wavefront/Alias OBJ format.
3.3 Panels

3.3.1 Tree Panel

This Panel (Figure 6) displays the structure of the current building, with a tree structure resembling the one described in section 2. The interface is quite simple, and only navigation is done through this panel.

Right clicking on any of the components brings up a small menu related to the object selected. An example is shown in Figure 7.

This menu provides three options:

- **Copy**: Copy the selected component. This is disabled at the root building level. The copy command does not copy subcomponents, only the intrinsic data of the component itself.

- **Add Subcomponent**: Add a subcomponent to this object. This is disabled at the window level.

- **Remove component**: Remove this component. This is disabled at the root building level.
3.3.2 Right Hand Side Panels

The right hand side panels have some similarities. The main one worth mentioning is the “Commit Changes” button at the bottom of the panel. Whenever the user changes a field in the panel, the Commit Changes button must be pressed in order to make these changes to the object. If you select another object without hitting the Commit Changes button, all information changed will be lost.

Below the Commit Changes button are three buttons that perform the same tasks on the component as the popup menu described in section 3.3.1.

3.3.2.1 Building Panel

![Building Information Panel](image)

*Figure 8 - Building panel*

When the top level of the hierarchy, building, is selected, this panel shows up. It enables you to enter the one feature unique at this level, the building type number.

From this panel there is also the option to add a new floor area to this building. This new floor area will contain values from defaults.txt. It is not allowed to copy or remove the building itself.
3.3.2.2 Floor Area Panel

Figure 9 - Floor area panel

When a floor area is selected, this panel shows up on the right. It enables you to enter all of the information about a particular floor area. Details of this information are provided in section 2.2, Floor Area.

The bottom left corner and floor size inputs both have two fields, representing the x and y coordinates of each point.

If you add to the number of floors in a floor area, Builder automatically defines the heights of these floors, by placing each new floor 3 m above the previous highest floor. To edit your own floor heights, the information must be entered in the floor heights text box for each floor. Specify it floor by floor, separating each height with a comma. So for example if you have three floors, you should enter into the text field something like 0.0, 2.5, 5.0.

When the number of floors is increased, all walls that already extend to the top of this floor area are raised to extend to the new top of the building. However, windows are NOT extended up as walls are. If the number of floors is decreased, any walls that extend above the new top of the building are lowered accordingly.

At the bottom are the options to copy this floor area, add a wall to this floor area, and remove the floor area itself. Adding a wall creates a new wall with data from defaults.txt. If you remove the floor area, all walls and windows attached to this floor area will also be removed.
3.3.2.3 Wall Panel

When a wall is selected, this panel shows up on the right. It enables you to enter all the information about a particular wall. Details of this information are provided in section 2.3, Wall.

The wall start coordinate and wall end coordinate both have two fields to enter, representing the $x$ and $y$ coordinates of each point. Walls must be entered in a way that they are either horizontal or vertical. This panel will not allow angled walls to be entered. Enter what floors this wall extends by using the Floor Start and End fields. Builder will not allow walls to be placed above its containing floor area's maximum height.

At the bottom are the options to copy this wall, add a window to this wall, and to remove the wall. Note that if a wall is removed, all its windows are removed as well.
3.3.2.4 Window Panel

When a window is selected, this panel shows up on the right. It enables you to enter all the information about the selected window. Details of this information are provided in section 2.4, Window.

To enter which floors this window exists on, place floor numbers in the Floors text field, with a comma separating each floor. To place this window on all floors, hit the “All Floors” button. Builder will not allow the window to exist on floors it cannot.

Window Horizontal and Window Vertical each have two fields, representing how far along its containing wall this window starts and finishes. These numbers need not be whole numbers.

At the bottom are options to copy this window and remove this window.
3.3.3 Building Display Panel

The bottom half of Builder is used to display a top down view of the current building.

The colour scheme shown in Table 5.

Table 5 - Building display panel colour scheme

<table>
<thead>
<tr>
<th>Colour</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>White</td>
<td>Wall</td>
</tr>
<tr>
<td>Blue</td>
<td>Window</td>
</tr>
<tr>
<td>Red</td>
<td>Currently selected wall in the Tree</td>
</tr>
<tr>
<td>Light Gray (Darker than the background)</td>
<td>Floor Area</td>
</tr>
<tr>
<td>Darker Gray</td>
<td>Currently selected floor area in the Tree</td>
</tr>
<tr>
<td>Yellow</td>
<td>Gridlines</td>
</tr>
</tbody>
</table>

Floor Areas and Walls can be selected on the building display by clicking on them. Walls do not have to be clicked on directly to select them (they are just 1 pixel wide after all).

A selection box at the top of the screen controls which floor of the building is displayed in the panel.
The final feature in this panel is the 3D View button. Clicking it opens up a wire-frame 3D view of the building, shown in Figure 13.

The 3D View can be rotated by dragging the mouse button from one area to another. The act of rotation is similar to if you were to be “grabbing” the building with your mouse button and moving it around by this method.
4. Tutorial

The following pages are a tutorial on how to create a CAEn Building in Builder. It details how to construct a 2 storey, 2 floor area building from scratch.

Start by opening Builder. We’ll use the new building that Builder provides by default when it starts.

From this point, click Add Floor Area. Now click on this floor area that was just created and set the floor size to (10,4) and hit Commit Changes. Since this building runs east-west, uncheck the option North South Ridge. Leave other information at default.

Now add walls around this building. Add three new walls, with the following coordinates:

Table 6 - Front area external walls

<table>
<thead>
<tr>
<th>Wall Start</th>
<th>Wall End</th>
</tr>
</thead>
<tbody>
<tr>
<td>(0,0)</td>
<td>(10,0)</td>
</tr>
<tr>
<td>(0,0)</td>
<td>(0,4)</td>
</tr>
<tr>
<td>(0,4)</td>
<td>(10,4)</td>
</tr>
</tbody>
</table>

The building should look like Figure 14.
Now add some exits to these outside walls. First add a door to the front. Instead of leaving a gap for doors, it is preferable that they be made windows to provide more control over the door. Select the wall that runs from (0,0) to (0,4) (It should be the second wall if you added the walls above in order) and click Add Window. Place the door at the very start of the wall and make it run one metre wide. That is, the window horizontal values should be 0 and 1. Make the door extend to the ground (set the window vertical values to 0 and 2). Finally, set all blocking characteristics (for Bullet, Line of Sight and Impact) of the door to 0.
Add two windows along the bottom wall. Select the wall running from (0,0) to (10,0) and add in two windows. Set the window horizontal for each window to (4,5) and (8,9) respectively, hitting Commit Changes for each window as you go. The floor plan should now look like Figure 15.

![Figure 15 - Building plan after adding windows](image)

Now we can split this floor area into some rooms. Add the following walls to our only floor area:

**Table 7 - Front area internal walls**

<table>
<thead>
<tr>
<th>Wall Start</th>
<th>Wall End</th>
</tr>
</thead>
<tbody>
<tr>
<td>(3,0)</td>
<td>(3,3)</td>
</tr>
<tr>
<td>(3,3)</td>
<td>(6,3)</td>
</tr>
<tr>
<td>(7,0)</td>
<td>(7,3)</td>
</tr>
<tr>
<td>(8,3)</td>
<td>(10,3)</td>
</tr>
</tbody>
</table>

Leave all other characteristics of this wall the same. The floor plan should look like Figure 16.
We've so far left the east side of this building open. The reason for this is that we are going to add a back end to the building. This will be another floor area that is two stories tall. We’ll make the bottom story an open conference room of sorts, and split the top up into offices. First add the floor area. Since this new floor area is offset from the bottom left corner of (0,0), we need to start it at (10,0).

Select the Building from the tree and click on Add Floor Area. Set the Bottom Left Corner to be (10,0). Set the Floor Size to be (7,12). Finally set the number of floors to be 2. Now add these walls to your new floor area. Set the floor end for each of these walls to 2. Leave all other characteristics to default.

Table 8 - Back area internal walls

<table>
<thead>
<tr>
<th>Wall Start</th>
<th>Wall End</th>
</tr>
</thead>
<tbody>
<tr>
<td>(0,0)</td>
<td>(0,3)</td>
</tr>
<tr>
<td>(0,0)</td>
<td>(7,0)</td>
</tr>
<tr>
<td>(7,0)</td>
<td>(7,12)</td>
</tr>
<tr>
<td>(0,4)</td>
<td>(0,12)</td>
</tr>
<tr>
<td>(0,12)</td>
<td>(7,12)</td>
</tr>
</tbody>
</table>

Your building should now look like Figure 17.
Note that if we select floor 2 using the floor selection above the display, the building now looks like Figure 18.

There appears to be a gap between the coordinates (10,3) and (10,4)! This is because we want a door on the first floor. We don’t, however, want this door on the second floor. We need to put something there. Add a wall to the second floor area with start coordinates...
(0,3) and end coordinates (0,4). Set the floor start and floor end values both to 2, so the wall only exists on the second floor. This should fill that gap.

Let's work on the first floor now by adding several wide windows around the room. Do the following:

- Add a 3 m wide window to the wall running from (0,4) to (0,12), starting 2 m along the wall.
- Add a 3 m wide window to the wall running from (0,0) to (7,0), starting 2 m along the wall.
- Add a 3 m wide window to the wall running from (0,12) to (7,12), starting 2 m along the wall.
- Add two 3 m wide windows to the wall running from (7,0) to (7,12), starting 2 m and 7 m along the wall respectively.

Leave all other characteristics of each window at their default value.

Remember that all the coordinates above are RELATIVE to the floor area contained in them, so they don’t actually match the coordinates on the floor plan. Now, if you select to view the first floor on the floor plan, it should look like Figure 19.

![Figure 19 - Building plan after adding windows to the conference room](image)

The first floor is done. Now let's move on to the second. Add some internal walls to split it up into a few offices. Note that there are no stairs in CAEn, but we'll leave some space for “imaginary” stairs.

Add the following walls to the second floor area. For ALL of these walls, set the floor start and floor end values to 2. This will restrict these walls to the second floor.
Table 9 - Back area top floor internal walls

<table>
<thead>
<tr>
<th>Wall Start</th>
<th>Wall End</th>
</tr>
</thead>
<tbody>
<tr>
<td>(3,0)</td>
<td>(3,3)</td>
</tr>
<tr>
<td>(4,0)</td>
<td>(4,3)</td>
</tr>
<tr>
<td>(0,4)</td>
<td>(3,4)</td>
</tr>
<tr>
<td>(3,4)</td>
<td>(3,7)</td>
</tr>
<tr>
<td>(4,4)</td>
<td>(7,4)</td>
</tr>
<tr>
<td>(4,4)</td>
<td>(4,7)</td>
</tr>
<tr>
<td>(0,8)</td>
<td>(3,8)</td>
</tr>
<tr>
<td>(3,9)</td>
<td>(3,12)</td>
</tr>
<tr>
<td>(4,8)</td>
<td>(7,8)</td>
</tr>
<tr>
<td>(4,9)</td>
<td>(4,11)</td>
</tr>
<tr>
<td>(4,11)</td>
<td>(7,11)</td>
</tr>
</tbody>
</table>

The building should now look like Figure 20, if you select to view Floor 2.

![Figure 20 - Floor 2 after adding office walls](image)

To finish the building, add some windows to these offices. To do this we need to go back to the original walls that make this second floor area. These are the ones we added a series of 3 m long windows to earlier.
For all of these windows, we need to make sure they only appear on the second floor of
the building. By default they appear only on the first floor. This means that in the floors
section of the window, the number 2 needs to appear instead of the 1 that appears by
default. Note that if you wanted these windows to appear on both floors, you would need
to place in this text field the sequence 1,2. Clicking the All Floors button on the window
panel does this for you.

Along the bottom wall running from (0,0) to (7,0), add two 1 m windows, starting at 1 m
and 5 m along the wall respectively.

Along the right hand wall running from (7,0) to (7,12), add three 1 m windows, starting at
2 m, 5 m and 9 m along the wall respectively.

Along the left hand wall running from (0,4) to (0,12), add two 1 m windows, starting at
1 m and 5 m along the wall respectively.

Along the top wall running from (0,12) to (7,12), add two 1 m windows, starting at 1 m
and 5 m along the wall respectively.

Figure 21 shows what the Window Panel should look like for the first window listed
above.

![Figure 21 - Window panel display for first window on top floor](image)

Once all these windows are added the floor plan should look like Figures 22 and 23. Figure
22 shows Floor 1, while Figure 23 shows Floor 2.
Figure 22 - Finished building, floor 1

Figure 23 - Finished building, floor 2
We have now completed the building. Let's finish by saving it. Using the top menus, click File -> Save. Type in a name of your choice then hit enter, and the file is saved.

The final step is to collate this building and perhaps some other buildings into a single CAEn Urban File. To do this, click Tools -> Create Urban Terrain File. The first dialog asks you to select the files to collate. Select your tutorial file, along with any others if you wish. To select multiple items at once, hold the Ctrl key to select one by one, or the Shift key to select a list. Figure 24 is an example of this first screen.

![Select Files to Concatenate](image)

Figure 24 - Concatenation dialog example

Click "Open" and another dialog appears. This asks for the name of the Urban Terrain File that will result from concatenating all the files selected in the previous dialog. Simply type an appropriate name then hit "Save". Unless you selected a file that isn't a proper building, the file should save correctly. This file is now ready to be input into CAEn.
DISTRIBUTION LIST

CAEn Building Editor Tool Manual

Denis R Shine

AUSTRALIA

DEFENCE ORGANISATION

Task Sponsor
COMD LWDC

S&T Program
Chief Defence Scientist
FAS Science Policy
AS Science Corporate Management
Director General Science Policy Development
Counsellor Defence Science, London
Counsellor Defence Science, Washington
Scientific Adviser Joint
Navy Scientific Adviser
Scientific Adviser - Army
Air Force Scientific Adviser
Scientific Adviser to the DMO

Systems Sciences Laboratory
Chief of Land Operations Division
Research Leader Operations Research
Head Task Force Modernisation (Paul Gaertner)
Task Manager (Justin Millikan)
Author (Denis Shine)

DSTO Library and Archives
Library Edinburgh
Defence Archives

Capability Systems Division
Director General Maritime Development
Director General Land Development
Director General Capability and Plans
Assistant Secretary Investment Analysis
Director Capability Plans and Programming
Director Trials

Office of the Chief Information Officer
Deputy CIO
Director General Information Policy and Plans
AS Information Strategies and Futures
AS Information Architecture and Management
Director General Australian Defence Simulation Office
Director General Information Services

Strategy Group
Director General Military Strategy
Director General Preparedness
Assistant Secretary Strategic Policy
Assistant Secretary Governance and Counter-Proliferation

Navy
Director General Navy Capability, Performance and Plans, Navy Headquarters
Director General Navy Strategic Policy and Futures, Navy Headquarters

Army
SimWing, LWDC
SO (Science), Deployable Joint Force Headquarters (DJFHQ) (L), Enoggera QLD
SO (Science) - Land Headquarters (LHQ), Victoria Barracks NSW

Joint Operations Command
Director General Joint Operations
Chief of Staff Headquarters Joint Operations Command
Commandant ADF Warfare Centre
Director General Strategic Logistics

Intelligence Program
DGSTA Defence Intelligence Organisation
Manager, Information Centre, Defence Intelligence Organisation email pdf
Assistant Secretary Corporate, Defence Imagery and Geospatial Organisation

Defence Materiel Organisation
Deputy CEO
Head Aerospace Systems Division
Head Maritime Systems Division
Chief Joint Logistics Command
Head Materiel Finance

Defence Libraries
Library Manager, DLS-Canberra
Library Manager, DLS - Sydney West

OTHER ORGANISATIONS
National Library of Australia
NASA (Canberra)
## UNIVERSITIES AND COLLEGES

- Australian Defence Force Academy
  - Library
  - Head of Aerospace and Mechanical Engineering
- Hargrave Library, Monash University
- Librarian, Flinders University

## OUTSIDE AUSTRALIA

### INTERNATIONAL DEFENCE INFORMATION CENTRES

- US Defense Technical Information Center
- United Kingdom - Dstl Knowledge Services
- Canada - Defence Research Directorate R&D Knowledge & Information Management (DRDKIM)
- NZ Defence Information Centre

### ABSTRACTING AND INFORMATION ORGANISATIONS

- Library, Chemical Abstracts Reference Service
- Engineering Societies Library, US

### UNITED KINGDOM

- Nick Stanbridge, Land Systems, Dstl Fort Halstead
  (via Mr Justin Millikan, LOD)

## SPARES

<table>
<thead>
<tr>
<th>Total number of copies:</th>
<th>Printed</th>
<th>PDF</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>33</td>
<td>1</td>
</tr>
</tbody>
</table>
##  DEFENCE SCIENCE AND TECHNOLOGY ORGANISATION

### DOCUMENT CONTROL DATA

<table>
<thead>
<tr>
<th>1. PRIVACY MARKING/CAVEAT (OF DOCUMENT)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

| 2. TITLE | CAEn Building Editor Tool Manual |
| 3. SECURITY CLASSIFICATION (FOR UNCLASSIFIED REPORTS THAT ARE LIMITED RELEASE USE (L) NEXT TO DOCUMENT CLASSIFICATION) |
| Document (U) |
| Title (U) |
| Abstract (U) |

| 4. AUTHOR(S) | Denis R. Shine |
| 5. CORPORATE AUTHOR |
| Systems Sciences Laboratory |
| PO Box 1500 |
| Edinburgh South Australia 5111 Australia |

<table>
<thead>
<tr>
<th>6a. DSTO NUMBER</th>
<th>6b. AR NUMBER</th>
<th>6c. TYPE OF REPORT</th>
<th>7. DOCUMENT DATE</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>8. FILE NUMBER</th>
<th>9. TASK NUMBER</th>
<th>10. TASK SPONSOR</th>
<th>11. NO. OF PAGES</th>
<th>12. NO. OF REFERENCES</th>
</tr>
</thead>
<tbody>
<tr>
<td>2004/1016525</td>
<td>ARM 03/030</td>
<td>COMD LWDC</td>
<td>25</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>13. URL on the World Wide Web</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>14. RELEASE AUTHORITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chief, Land Operations Division</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>15. SECONDARY RELEASE STATEMENT OF THIS DOCUMENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved for public release</td>
</tr>
</tbody>
</table>

OVERSEAS ENQUIRIES OUTSIDE STATED LIMITATIONS SHOULD BE REFERRED THROUGH DOCUMENT EXCHANGE, PO BOX 1500, EDINBURGH, SA 5111

<table>
<thead>
<tr>
<th>16. DELIBERATE ANNOUNCEMENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Limitations</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>17. CITATION IN OTHER DOCUMENTS</th>
<th>Yes</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>18. DEFTEST DESCRIPTORS</th>
</tr>
</thead>
<tbody>
<tr>
<td>User interface</td>
</tr>
<tr>
<td>Training</td>
</tr>
<tr>
<td>Simulation</td>
</tr>
<tr>
<td>Windows (operating system)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>19. ABSTRACT</th>
</tr>
</thead>
</table>

Creation and modification of buildings within the Close Action Environment (CAEn) wargame can be a complex and time consuming task. The CAEn Building Editor Tool, or Builder, simplifies this process by providing an efficient graphical interface to edit CAEn buildings. The use of Builder can greatly speed up the production of urban environments within CAEn.